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Vision 

To excel in management education and research by nurturing the youth to become global 

management leaders. 

Mission 

We intend to empower the capabilities of the young managers to face various challenges in the 

global community by raising their acquired skills and knowledge.  

In pursuit of excellence, we provide training and development activities, cultivate research skills, 

enhance entrepreneurship abilities and offer employability in multi-domain business 

organizations.  

 

Quality Policy 

Our policy is to nurture and build diligent and dedicated community of engineers providing a 

professional and unprejudiced environment, thus justifying the purpose of teaching and satisfying 

the stake holders. 

 
 

A team of well qualified and experienced professionals ensure quality education with its practical 

application in all areas of the Institute. 



 

Philosophy 

The essence of learning lies in pursuing the truth that liberates one from the darkness of ignorance 

and Institute of Aeronautical Engineering firmly believes that education is for liberation. 

 
 

Contained therein is the notion that engineering education includes all fields of science that plays a 

pivotal role in the development of world-wide community contributing to the progress of 

civilization. This institute, adhering to the above understanding, is committed to the development 

of science and technology in congruence with the natural environs. It lays great emphasis on 

intensive research and education that blends professional skills and high moral standards with a 

sense of individuality and humanity. We thus promote ties with local communities and encourage 

transnational interactions in order to be socially accountable. This accelerates the process of 

transfiguring the students into complete human beings making the learning process relevant to life, 

instilling in them a sense of courtesy and responsibility. 
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Program Outcomes (POs) 

PO1 Managerial Skills: Apply knowledge of management theories and practices to 
solve business problems. 

PO2 Decision making Skills: Foster analytical and critical thinking abilities for data-
based decision making. 

PO3 Ethics: Ability to develop value based leadership ability. 

PO4 Communication Skills: Ability to understand, analyze and communicate global, 
economic, legal, and ethical aspects of business. 

PO5 Leadership Skills: Ability to lead themselves and others in the achievement of 
organizational goals, contributing effectively to a team environment. 

PO6 Entrepreneurial and Innovation Skills: Demonstrate the skills in evaluating 

business opportunity and identifying sources of potential funding, and develop as 

successful entrepreneurs. 

PO7 Strategic Skills: Analyze and formulate managerial strategies to sustain in 
dynamic global business environment. 

PO8 Technology Skills: Inculcate and develop technical skills to face the competitive 
world successfully. 

Program Educational Objectives (PEOs) 

PEO1    To impart adequate knowledge of management theories and concepts to enhance 
research and learning for continuous growth and development. 

PEO2 To provide the learners with exposure to solve business situations using 
management tools, to analyze and create newer opportunities in industry. 

PEO3 To achieve appropriate communication skills and higher levels of proficiency for 
successful career in Industry, Business and Entrepreneurship. 

PEO4 To demonstrate the ability to maintain knowledge of emerging technologies to 

address the critical needs of the seamless strategic business operations. 



ATTAINMENT OF PROGRAM OUTCOMES 

& 

PROGRAM SPECIFIC OUTCOMES 

 

 

Exp. No Experiment 
Program Outcomes 

Attained 

1 INTRODUCTION OF INFORMATION TECHNOLOGY PO2 

2 ROLE OF INFORMATION SYSTEMS PO2 

3 INTRODUCTION TO MS EXCEL PO2 

4 BASICS OF MS EXCEL PO5 

5 VARIOUS FORMATTING STYLES IN MS EXCEL PO5 

6 WORKING WITH TEXT AND LOOKUP FUNCTIONS PO7 

7 WORKING WITH FUNCTIONS PO5 

8 DATA ANALYSIS WITH MS EXCEL PO7 

9 CREATION OF VARIOUS CHARTS IN MSEXCEL PO5 

10 LaTeX FORMATTING PO8 

11 VARIOUS FORMATTING STYLES IN LaTeX PO8 

12 GRAPHICS AND TABLES IN LaTeX PO8 



LIST OF EXPERIMENTS 
 

WEEK-1 INTRODUCTION OF INFORMATION TECHNOLOGY 

  Introduction to Information Technology and Information Systems 

WEEK-2 ROLE OF INFORMATION SYSTEMS 

  Role of Information Systems in an organization and Decision Support Systems (DSS) 
 

WEEK-3 INTRODUCTION TO MS EXCEL 

  MS Excel as Spreadsheet based DSS - Features of MS Excel, Uses of MS Excel. 
 

WEEK-4 BASICS OF MS EXCEL 

  Spreadsheet Orientation: Accessing, overview of toolbars, saving spreadsheet files, Using help and resources.   
Creating a Scheduler:- Gridlines, Format Cells, Summation, auto fill, Formatting Text 

 

WEEK-5 VARIOUS FORMATTING STYLES IN MS EXCEL 

  Calculating GPA - Features to be covered:- Cell Referencing, Formulae in spreadsheet – average, std. deviation, 

Charts, Renaming and Inserting worksheets, Hyper linking, Count function, Sorting, Conditional formatting. 

WEEK-6   WORKING WITH TEXT AND LOOKUP FUNCTIONS 

  Create a spreadsheet by using the following  functions : Text Functions, Lookup Functions. 

WEEK-7 WORKING WITH FUNCTIONS 

Create a spreadsheet by using the following functions : Date and Time Functions,  
Math and Statistical Functions, Database Functions. 

WEEK-8 DATA ANALYSIS WITH MS EXCEL 

Create a spread sheet document by using data analysis concept with what - if Analysis - Data 

Tables, Scenario Manager, Goal Seek. 
 

WEEK-9 CREATION OF VARIOUS CHARTS IN MSEXCEL 

  Apply data analysis concept for creating Pivot Tables and Pivot Charts. 

WEEK-10 LaTeX FORMATTING 

  Introduction of LaTex and LateX document formatting: 

  Create a LaTeX document with following formatting: All margins with 1.5, headings with bold, text with normal, 

chapter name with blue color, line space with 1.5. 

WEEK-11 VARIOUS FORMATTING STYLES IN LaTeX 

  Using LaTeX to create project certificate. Features to be covered:- Formatting Fonts in word, Drop Cap in word, 
Applying Text effects, Using Character Spacing, Borders and Colors, Inserting Header and Footer, Using Date 
and Time option in both LaTeX. 

 

WEEK-12 GRAPHICS AND TABLES IN LaTeX 



  Create a LaTeX  documents with images and image caption at centre alignment, table with thick border and table 
caption with centre alignment, row height, content with cell centre alignment. 

 
 

  Text Books: 

   1. Gross Debra, "Succeeding in Business with Microsoft Excel - 2013: A Problem Solving Approach",    
Cengage Learning, 1st Edition, 2014. 

  REFERENCE BOOKS: 

1. Paul Mcfedries, "Excel 2013 Formulas and Functions", Pearson Education, , 1st Edition,2013. 
2. Dodge Mark, Stinson Craig, "Microsoft Excel 2013 Inside Out", Prentice Hall of India, 1st Edition, 2013. 

3. Guy Hart Davis, How to do everything with Microsoft Office Excel, Tata McGraw Hill, Revised 

1st Edition, 2010. 

4. Lisa Miller, "MIS Cases: Decision Making with Application Software", Pearson Education, Revised 

1st Edition, 2011. 

5. Giridhar Joshi, "Management Information Systems", Oxford University Press, Revised 1st Edition, 

2013. 

  WEB REFERENCES: 

1. http://www.abebooks.com/servlet/SearchResults?isbn.pdf. 

2. http://www.amazon.in/Succeeding-Business-Microsoft-Excel-2013 

3. http://ctan.org/pkg/bibtopic 

  E-Text Books: 

    1. http://www. http://www.chegg.com/textbooks/succeeding-in-business 
    2.  http://www.cengage.com.au/product/title/succeeding-in. 

http://www.abebooks.com/servlet/SearchResults?isbn.pdf
http://www.amazon.in/Succeeding-Business-Microsoft-Excel-2013
http://ctan.org/pkg/bibtopic
http://www/
http://www/
http://www/
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                                 WEEK-1 

       Introduction of Information Technology 

               An Overview of Computer Systems 

Introduction: 

Computer systems are extremely complex objects. Even the smallest systems consist of millions of 

individual parts. Each part is relatively simple in its function and easy to understand. It is only when 

these millions of simple parts interact with each other that we develop the complex structures that 

comprise our modern computing systems. In this lesson, we take a brief look at the major components 

of a computing system. In subsequent lessons, we will study each component in more detail. 

Data and information processing have been previously defined as the transformation of un organized 

raw material or data into useful information. This processing may be done manually or with the help 

of mechanical and electronic devices. It is common to refer to the collection of personnel, equipment, 

software, and procedures that perform the data and information processing functions as an 

information processing system. Very often, when a computer is used, the system is referred to as a 

computer system. We will use the term computer system to refer to the hardware and software 

exclusively, and reserve the term information processing system to include the people and 

procedures. In the early days of computing, when the computer was used simply to replace manual 

operations such as payroll, the term that was used was EDP, or electronic data processing system.  

In the future we will continue to build computers out of these three logical components but the 

electronic implementation will change. Systems will still include people, machines, software, and 

procedures, although our techniques for defining them will become more rigorous. As you read 

through the following material, try to distinguish those concepts that are apt to change substantially 

and those that will not. 

The Hardware (Equipment) 
 

Hardware can be categorized in numerous ways. Below we will look at the central unit, or central 

processing unit (CPU), and the associated equipment consisting of auxiliary storage, input and output 

devices, and communication devices. All of the units that are connected to the central processing 

unit are called peripheral devices.  

Motherboard 
 

The motherboard is the main component of a computer. It is a board with integrated circuitry that 

connects  the  other  parts  of  the  computer  including  the CPU,  the RAM,  the  disk  drives  (CD, 

DVD, hard disk, or any others)  as  well  as  any  peripherals  connected  via  the  ports  or  the 

expansion slots. 

 

Expansion cards 
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An expansion card in computing is a printed circuit board that can be inserted into an expansion slot 

of a computer motherboard or backplane to add functionality to a computer system via the expansion 

bus. Expansions cards can be used to obtain or expand on features not offered by the motherboard. 

 

Central Processing Unit 
 

The part of the computer system that performs the logic transformations on the data and controls all 

the other devices is the central processing unit, or CPU. The CPU interprets and executes the program 

instructions. It has three main components: the arithmetic-logic unit (ALU), the control unit, and the 

primary storage unit. In many personal computers, the ALU and control unit are fabricated as a single 

component on a single silicon chip with the primary storage on separate. 

Auxiliary Storage Devices 
 

In today's modern computing systems, it is necessary to have another form of memory. It is often the 

case that the main memory is not large enough to accommodate all the data necessary for a particular 

application. It is also the case that main memory is only used to hold data that are currently being 

processed. When not in use, data are stored on auxiliary storage devices. Auxiliary storage devices 

(sometimes called secondary storage) can overcome this difficulty. The most common devices used 

are magnetic disk drives, CDs or magnetic tapes used for backups. Many personal computers still 

use a flexible disk called a floppy. Common memory sizes for personal. 

Classification of Computer Systems 
Any classification of computer systems is an ephemeral thing. It will be at least a year from the time 

this lesson was first typed to the time you are reading it in class. In that time, some of the physical 

classificationsthatwehavedevisedwillbeoutdated. 

 

Mainframes 
 

The term most commonly used for the largest general purpose computing system is a mainframe 

computer. The cost ranges from several hundred thousand to several million dollars. This cost has 

stayed relatively constant since the early 1950s; however, the power mainframes. of the mainframe 

has increased dramatically. 

Mainframe systems are designed for large-scale scientific and commercial applications. Their 

scientific applications range from long-range weather forecasting to the analysis of complex data 

from high energy nuclear physics experiments. Typical commercial applications are the very 

complex airline reservation systems and massive banking systems. 

Minicomputers 
 

Originally, the mini had very limited memory and a single logic unit. The most attractive thing about 

it was its cost. Relatively inexpensive computing capacity couldbe purchased with a mini,  so 

management was willing to buy these systems for specialized purposes such as process control. 

Today the capacity of many of the minis found in industry rivals the mainframes of a few years ago. 

Many of the applications that were exclusively run on the mainframes are being done on minis and 
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the distinction between the two systems, mainframe and mini, has become clouded.  

Microcomputers 
 

Microcomputers are widely used as personal workstations in almost all aspects of business, industry, 

and government. They are found extensively in the home and in educational institutions. Although 

there are microcomputer systems that are capable of serving several users at once, most are used by 

one person. This has led to the term personal computer (PC), which is used interchangeably with the 

term micro. Among the most popular micro computers are  those produced by IBM, Apple, and 

Tandy-Radio Shack. An entire industry has developed manufacturing PCs that function identically 

to the IBM PC. These machines are often called PC clones. In 1987 IBM introduced its next 

generation of PCs, the Personal System 2. It is a family of products that significantly increases the 

power of the earlier machines. 

Supercomputers 
 

One additional category of computing systems we have not discussed is commonly referred to as the 

supercomputer. These systems have extremely large memories and are very fast. They cost in the 

range of millions dollars. They are most commonly used for very large computational problems. 

These systems are so complex that they usually have a mainframe computer that functions as the 

input and output device for the supercomputer. A good definition of a supercomputer is simply the 

largest and most powerful computer that is available at the present time. Supercomputers have found 

application in long-range weather forecasting and other very complex problems that require 

enormous amounts of computation. Manufacturers of the largest supercomputers are Cray Research 

and Control Data Corporation. 

 

• The BIOS (basic input/output system) gets the computer system started after you turn it on and 

manages the data flow between the operating system and attached devices such as the hard  disk, 

video adapter, keyboard, mouse, and printer. 

• The boot program loads the operating system into the computer's main memory or random access 

memory(RAM). 

• An assembler takes basic computer instructions and converts them into a pattern of bits that the 

computer's processor can use to perform its basic operations. 

• A device driver controls a particular type of device that is attached to your computer, such as a 

keyboard or a mouse. The driver program converts the more general input/output instructions of 

the operating system to messages that the device type can understand. 

 

 

Computer Software:Software is a set of programs, which is designed to perform a well- defined 

function. A program is a sequence of instructions written to solve a particular problem. 

 

http://searchcio-midmarket.techtarget.com/definition/bit
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There are two types of software − 

 
• System Software 

• Application Software 
 

System Software 

The system software is a collection of programs designed to operate, control, and extend the 

processing capabilities of the computer itself. System software is generally prepared by the computer 

manufacturers. These software products comprise of programs written in low-level languages, 

which interact with the hardware at a very basic level. System software serves as the interface 

between the hardware and the end users. 

 

Some examples of system software are Operating System, Compilers, Interpreter, Assemblers, etc. 
 

 
 

Here is a list of some of the most prominent features of a system software: 

 
• Close to the system 

• Fast in speed 

• Difficult to design 

• Difficult to understand 

• Less interactive 

• Smaller in size 

• Difficult to manipulate 

• Generally written in low-level language 
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Application Software 

Application software products are designed to satisfy a particular need of a particular environment. 

All software applications prepared in the computer lab can come under the category of Application 

software. 

 

Application software may consist of a single program, such as Microsoft's notepad for writing and 

editing a simple text. It may also consist of a collection of programs, often called a software package, 

which work together to accomplish a task, such as a spreadsheet package. 

 

Examples of Application software are the following : 

 
• Payroll Software 

• Student Record Software 

• Inventory Management Software 

• Income Tax Software 

• Railways Reservation Software 

• Microsoft Office Suite Software 

• Microsoft Word 

• Microsoft Excel 

• Microsoft PowerPoint 

 
 

Features of application software are as follows: 

 
• Close to the user 

• Easy to design 

• More interactive 

• Slow in speed 

• Generally written in high-level language 

• Easy to understand 

• Easy to manipulate and use 

• Bigger in size and requires large storage space 
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Information Technology and Business 

 
An Information System (IS) is an organized system for the collection, organization, storage and 

communication of information. More specifically, it is the study of complementary networks that 

people and organizations use to collect, filters, process, create and distribute data. 

 

―Aninformationsystem(IS)isagroupofcomponentsthatinteracttoproduceinformation.‖ 

 
A computer information system is a system composed of people and computers that processes or 

interprets information. The term is also sometimes used in more restricted senses to refer to only the 

software used to run a computerized database or to refer to only a computer system. 

 

Information Systems is an academic study of systems with a specific reference to information and 

the complementary networks of hardware and software that people and organizations use to collect, 

filter, process, create and also distribute data. An emphasis is placed on an information system having 

a definitive boundary, users, processors, storage, inputs, outputs and the aforementioned 

communicationnetworks. 

 

Any specific information system aims to support operations, management and decision-making. An 

information system is the information and communication technology (ICT) that an organization uses, 

and also the way in which people interact with this technology in support of businessprocesses. 

 

Some authors make a clear distinction between information systems, computer systems, and business 

processes. Information systems typically include an ICT component but are not purely concerned 

with ICT, focusing instead on the end use of information technology. Information systems are also 

different from business processes. Information systems help to control the performance of business 

processes. 

 

Alter argues for advantages of viewing an information system as a special type of work system. A 

work system is a system in which humans or machines perform processes and activities using 

resources to produce specific products or services for customers. An information system is a work 

system whose activities are devoted to capturing, transmitting, storing, retrieving, manipulating and 

displayinginformation. 

 

As such, information systems inter-relate with data systems on the one hand and activity systems on 

the other. An information system is a form of communication system in which data represent and are 

processed as a form of social memory. An information system can also be considered a semi-formal 

language which supports human decision making and action. 

 

Information systems are the primary focus of study for organizational informatics. 
 

Types of information system 
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The "classic" view of Information systems found in the textbooks in the 1980s was a pyramid of 

systems that reflected the hierarchy of the organization, usually transaction processing systems at the 

bottom of the pyramid, followed by management information systems, decision support systems, and 

ending with executive information systems at the top. Although the pyramid model remains useful 

since it was first formulated a number of new technologies have been developed  and new categories 

of information systems have emerged, some of which no longer fit easily into the original 

pyramidmodel. 

 

Some examples of such systems are: 

 
 Data Warehouses:  In computing,  a data  warehouse (DW or DWH),   also   known   as an 

enterprise data warehouse (EDW), is a system used for reporting and data analysis, and is 

considered a core component of business intelligence. 

 Enterprise Resource Planning: Enterprise resource planning (ERP) is business process 

management software that allows an organization to use a system of integrated applications 

to manage the business and automate many back office functions related to technology, 

services and human resources. 

 Enterprise System: Enterprise systems (ES) are large-scale application software packages 

that support business processes, information flows, reporting, and data analytics in complex 

organizations. 

 Expert Systems: In artificial intelligence, an expert system is a computer system that 

emulates the decision-making ability of a human expert. Expert systems are designed to solve 

complex problems by reasoning about knowledge, represented mainly as if–then rules rather 

than through conventional procedural code. 

 Search Engines: A web search engine is a software system that is designed to search for 

information on the World Wide Web. The search results are generally presented in a line of 

results often referred to as search engine results pages (SERPs). The information may be a 

mix of web pages, images, and other types of files. 

 Geographic Information System: A geographic information system (GIS) is a system 

designed to capture, store, manipulate, analyze, manage, and present spatial or geographic 

data. The acronym GIS is sometimes used for geographic information science (GIScience) to 

refer to the academic discipline that studies geographic information systems and is a large 

domain within the broader academic discipline of geo informatics. 

 Global Information System: A global information system (GIS) is an information system 

which is developed and/or used in a global context. A global information system(GIS)is 
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any information system which attempts to deliver the totality of measurable data worldwide 

within a defined context. 

 Office   Automation:   Office   automation refers   to   the   varied computer machinery and 

software used to digitally create, collect, store, manipulate, and relay office  information 

needed for accomplishing basic tasks. Raw data storage, electronic transfer, and the 

management of electronic business information comprise the basic activities of an office 

automation system. Office automation helps in optimizing or automating existing office 

procedures. 

 

A computer (based) information system is essentially an IS using computer technology to carry out 

some or all of its planned tasks. The basic components of computer-based information systems are: 

 

 Hardware- these are the devices like the monitor, processor, printer and keyboard, all of 

which work together to accept, process, show data and information. 

 Software- is the programs that allow the hardware to process the data. 

 Databases- are the gathering of associated files or tables containing related data. 

 Networks- are a connecting system that allows diverse computers to distribute resources. 

 Procedures- are the commands for combining the components above to process information 

and produce the preferred output. 

 

Information Technology 

What is Information Technology? 
 

A 1958 article in Harvard Business Review referred to information technology as consisting of three 

basic parts: computational data processing, decision support, and business software. 

This time period marked the beginning of IT as an officially defined area of business; in fact, this 

article probably coined the term. 

Over the ensuring decades, many corporations created so-called "IT departments" to manage the 

computer technologies related to their business. Whatever these departments worked on became the 

de facto definition of Information Technology, one that has evolved over time. Today, IT departments 

have responsibility in areas like 

• Computer Tech Support 
 

• Business Computer Network and Database Administration 
 

• Business Software Deployment 
 

• Information Security 

 

                                 WEEK-2 



 
9 | P a g e  

                 Role of Information Systems 

Role of Information Technology in Manufacturing Sector 

 
IT plays an important role in various sectors and industries. Similarly, IT strives to make things 

simpler in the manufacturing sector as well. 

In an industry that automates things for the benefit of humankind, IT helps making the manufacturing 

process less cumbersome and more automated. IT helps drastically in delivering just-in-time insights, 

swift visibility, and seamless innovation for implementing new age solutions. 

Role of Information Technology in Public Sector 

At a time when public finances are under strain, governments must deliver new services and improve 

existing oes, while operating more efficiently and with greater transparency.  

What we do 

 

We help governments around the world address these challenges head-on. We draw upon deep client work 

and best practices from the global public and private sectors to help governments effectively utilize 

technology. Our strength lies in our unique ability to marry a client‘s strategic vision with theoperational 

and technological initiatives necessary to actualize that vision, including IT infrastructure consolidation, 

application rationalization, IT megaproject value assurance, and leanIT. 

 

Examples of our work 

 

In the past 5 years alone, we have supported more than 2,000 public-sector projects in 85 countries. Many 

of these projects had a significant focus on IT. Examples include the following: 

 

• Working with a federal agency to give healthcare providers greater and easier access to healthcare 

data and, ultimately, improve the quality of patient care 

 

• Helping a national government develop a broad policy on technology best practices and usage 

guidelines 

 

• Supporting a regional government‘s efforts to improve operations and collaboration across 

agencies by consolidating support functions into centralized shared services and centers of 

excellence 

 

• Working with a government agency to create a best-practice IT organization focused on improving 

existing services and launching new services 

 

• Advising a government on cyber security risks and helping to develop a strategy for safeguarding 

IT operations 

Through extensive work  in  both  the  public  and  private  sectors,  we—along  with  colleagues  in  our 
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Business Technology Practice—have developed and tested a robust set of proprietary research, data, tools, 

and solutions that allow us to better serve our clients. 

Information Technology & Its Role in the Modern Organization 

Information technology (IT) has become a vital and integral part of every business plan. From multi-

national corporations who maintain mainframe systems and databases to small businesses that own a 

single computer, IT plays a role. The reasons for the omnipresent use of computer technology in 

business can best be determined by looking at how it is being used across the business world. 

Communication: 

For many companies, email is the principal means of communication between employees, suppliers 

and customers. Email was one of the early drivers of the Internet, providing a simple and inexpensive 

means to communicate. Over the years, a number of other communications tools have also evolved, 

allowing staff to communicate using live chat systems, online meeting tools and video-conferencing 

systems. Voice over internet protocol (VOIP) telephones and smart-phones offer even more high-tech 

ways for employees to communicate. 

Inventory Management: 

When it comes to managing inventory, organizations need to maintain enough stock to meet demand 

without investing in more than they require. Inventory management systems track the quantity of each 

item a company maintains, triggering an order of additional stock when the quantities fall below a 

pre-determined amount. These systems are best used when the inventory management system is 

connected to the point-of-sale (POS) system. The POS system ensures that each time an item is sold, 

one of that item is removed from the inventory count, creating a closed information loop between all 

departments. 

Data Management: 

The days of large file rooms, rows of filing cabinets and the mailing of documents is fading fast. 

Today, most companies store digital versions of documents on servers and storage devices. These 

documents become instantly available to everyone in the company, regardless of their geographical 

location. Companies are able to store and maintain a tremendous amount of historical data 

economically, and employees benefit from immediate access to the documents they need.  
 

Management Information Systems 

Storing data is only a benefit if that data can be used effectively. Progressive companies use that data 

as part of their strategic planning process as well as the tactical execution of that strategy. 

Management Information Systems (MIS) enable companies to track sales data, expenses and 

productivity levels. The information can be used to track profitability over time, maximize return on 

investment and identify areas of improvement. Managers can track sales on a daily basis, 

allowing them to immediately react to lower-than-expected numbers by boosting employee 

productivity or reducing the cost of an item. 
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Customer Relationship Management 

Companies are using IT to improve the way they design and manage customer relationships. 

Customer Relationship Management (CRM) systems capture every interaction a company has with a 

customer, so that a more enriching experience is possible.  

 

Role of Information Technology in Management 

The role of Information Technology to the world had become unimaginable - it plays very important 

roles, not just in business management - but in other aspects of businesses as well. 

Traditional businesses do things in very ―analog basis. Meaning, they have non-computerized 

methods of doing things - from transaction, attendance, employee management and list, stock keeping 

and other aspects of the business. They do a lot of things by means of pen and papers, and are pretty 

much trained and are very used to do so. 

 

The Importance of Information Technology in Education 

 
The world of education is changing as the modern world continues to grow. With so much progress 

happening, it‘s important that education be able to reach students in new ways so that their students 

are prepared for the future. The students of today are the leaders, inventors, teachers, and businessmen 

(and women) of tomorrow. Without the proper skills, these students will not have the preparation 

needed to survive. 

 

The Importance of Information Technology in Finance 

 
Information technology has also made it faster and easier than ever to send or receive money. It‘s now 

also easier to open an online small business to sell whatever you might want. If you don‘t want to 

have to file for a domain name, set up a website, and all the other steps required for 

registering an online business, you can use other websites like Amazon, eBay, and Etsy to sell things. 

 

The Importance of Information Technology in Healthcare 

 
Improvements in information technology have allowed for great reform in healthcare. Most medical 

offices can now send and receive digital medical information from doctors you‘ve had in the past. 

Changes like this allow costs to be lowered and increase the amount of time doctors can spend on 

patients compared to paper work. 

Along with the changing the amount of paperwork required at your medical office, information 

technology has also updated the technology a doctor can use to diagnose or treat you 

 

The Importance of Information Technology in Security 

 
With so many transactions done online and so much information available online, it‘s important to 

keep all of that safe. Information technology makes it possible for your online data to stay secure until 
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accessed by the proper channels.  

Information Technology and Business 

 Functions of manager: 

Managers have 5 basic functions. They are 

1. Planning 

2. Organizing 

3. Staffing 

4. Directing 

5. Controlling 
 

Other functions are 

1. Coordinating 

2. Reporting 

3. Budgeting 
 

Managers have to plan or narrow goals from their broadcast to most intricate form. They must 

organize and create a structure for daily tasks and communication. They must hire and fire people 

from various positions. They must serve as directing influence on staff behavior and morale. They 

must also have control over all the aspects of the company. 

 Planning − The basic step required for any project, big or small, is the planning stage. The 

manager needs to plan the schedule and give the blueprint of how the task is to be done with 

all the necessary details, and also the manager should have a backup plan that if this doesn‘t 

work then what next. Example − There is a new project, how to start, human resource 

required, resources required, etc., everything should be planned. 

 Organizing − Next comes the organizing part, where the manager needs to synchronize and 

have to make sure everything is going according to the plan. Everything should work  as per 

the plan, and if not then the manager needs to look into the issue and make it work as planned. 

Example − A software tester is required, so organize the venue, date and time to interview 

those eligible for the post. 

 Staffing − In simple words, staffing means grouping of people into different teams and 

allotting different tasks to them. If the team members have some disputes then the team 

member needs to report to the team leader who will forward it to the manager and the issue 

will be taken care of. Example − Assembling a new team for a new project. 

 Directing/Leading − It is a manager‘s responsibility to guide the employees in all situations 

in order to avoid conflicts and delay in the task. Manager has to lead the employees so that 

they can get a  clear  idea  about  what  is  to  be  done  and  how  to  do it. Example − a team 

needs a team leader to look after each task that is accomplished, in- process, or aborted. 

 Controlling − Last but of course not the least role played by the manager is having everything 

under control. Whether it is the budget, or resource allocation, everything should be in order. 
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Example − All members of a team cannot be granted leave on the same day, as it affects work 

delivery. 

 Coordinating − It means bringing all the employees together by forming an efficient 

relationship  and  making  them  feel  comfortable  to  share  their  views  and  issues freely. 

Example − Coordinating the schedule for a project. 

 Reporting − The manager has to keep updated information about all the ongoing tasks, and 

it is the sole responsibility of the manager to report the updated status to the higher authorities; 

while all the employees are bound to report to the manager. Example − Keeping the respective 

directors informed about the progress on their respective projects. 

 Budgeting − A task has to be completed within the given time frame as well as it should be 

cost efficient. The manager needs to be double sure that all the amount invested in the project 

doesn‘t exceed the budget given and in case of imbalance, the budgeting manager has to report 

to the management. Example − If budget allows to place three employees then five employees 

cannot be assigned for the task. 

 

Levels of Management and Their Functions: 

Level of management is to divide authority and responsibility of the organization among the various 

managerial positions. Basically management is divided into three levels in which different managerial 

functions are to be performed by different managerial positions holders who are named differently in 

different levels. Their authorities and responsibilities are different, however, they all perform well, 

effectively, efficiently and coordinately the corporate goals surely achieved. 

 

 
These three levels of management can be studied as follows: 

 

1. Top level management: 

Top level management is concerned with the broad policy framework and is related to develop 

attitude. It consists of board of directors, chairman, managing directors, strategists and alike. 
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They are responsible for the welfare, and survival of the organization. In this level, the 

corporate goals, missions and objectives are determined and a detailed action plan and 

strategies for the same are formulated. 

 
Functions of top level management 

i. To formulate and determine the objectives and define the goals of the business. 

ii. To establish policies and prepare plans to attain goals. 

iii. To set up an organizational structure to conduct the operations as per the plans. 

iv. To provide overall direction in the organization. 

v. To assemble the resources necessary for the attainment of the policy and execution 

of the plan. 

vi. To control effectively the business operations. 

vii. To judge and evaluate the results. 

Distinction between Management and Administration: 

Following are the main differences between management and administration: 

i. Nature of functions: Management is executive function. Administration is thinking 

or determinable function. 

ii. Types of work: Management activates the policies and plans into action laid down by 

administration. It is concerned with implementation. Administration relates with 

formulation of objective, mission and purpose and policies of an organization. 

iii. Level of authority: Management is an operative level of the organization. 

Administration is top level activity. 

iv. Decision making: Management may take decision; however, it is influenced by 

values, opinions and beliefs of administration. Administration takes decision 

considering the public opinion, government policies, ritual norms and social values. 

v. Use: The term 'management' is used in private business sector. The term 

'administration' is used in public or government sectors of undertakings. 

vi. Functions: The main functions of management are directing, motivating and 

controlling. The main functions of administration are planning and organizing. 

vii. Ability: Management requires technical and professional ability. Administration 

requires only administrative quality rather than technical quality. 

viii. Status of performer: Managerial personnel consists of paid employees with 

specialized knowledge to perform the given tasks. Administrative groups consist of 

owners who invest capital and participate in profit in the form of dividend. 

2. Middle level management 

The middle level consists of departments, divisions and sections, in which the respective 

chiefs, heads or managers are concerned with the tasks of implementing the policies and plans 

prepared by the top level management. They are the real subordinates to top managers. Being 

in the middle, the managers have to perform as a link between top level and lower level 
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management. 

Functions of middle level management 

i. To implement the task set by top management. 

ii. To interpret the policies framed by the top management. 

iii. To run the organization effectively and efficiently. 

iv. To cooperate for the smooth functioning of the organization. 

v. To coordinate between different departments. 

vi. To recruit, select and train the employees for better functioning of the departments. 

vii. To issue the instructions to the lower level management. 

viii. To motivate the workers and staffs for higher productivity. 

ix. To lead the department and build-up and organizational spirit. 

x. To report and make suitable recommendations to the top level management for the 

better execution of the plans and policies. 

 
Characteristics of Management: 

The main features of management are as follows: 

I. Management is a Distinct Process: Management is a distinct process which is 

followed and performed by the organization to determine the accomplishment of the 

organizational objective and continue till the objectives are achieved. 

II. Management is Art And Science: Management is an art because the result of 

management depends upon the capacity and skill of personnel, managers and 

administrators. Management is science because it has developed certain principles 

which are universally accepted and can be applied. 

III. Management is a Profession: Due to the established principles of management, it has 

become profession. Management has a systematic and specialized body of knowledge, 

principles and techniques which can be taught as well as applied in practice. 

IV. Management is Goal Oriented: Principles of management are goal oriented. The 

goals may be to maximize profit, to maximize efficiency, to determine economy, to 

render social satisfaction and welfare to the people. 

V. Management is a Group Activity: Management is a group activity because it is a 

collective approach to management. It refers to group efforts. 

VI. Management is an Integrating Process: The important element of management is 

the integration of human and other resources for effective performance. Management 

integrates men, money and materials for carrying out the operations for achieving the 

stated goals. 
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VII. Social Process: Management is social process. It comes under humanistic concept and 

deals with people. 

VIII. Management is a Dynamic Function: Management is a dynamic function because it 

has to be performed regularly and continuously. Management also operates in an ever-

changing environment. 

IX. Intangible: Management is virtually intangible. It is an unseen force and process, 

however its results are apparent. It can be felt on the basis of work environment and 

working conditions; and its effectiveness and productiveness can be judged on the 

basis of the results. 

X. Multidisciplinary activity: Management is a mixture of knowledge of different 

disciplines. It draws knowledge and concepts from economics, psychology, sociology, 

mathematics, statistics, operation research, production technology etc. It integrates the 

ideas and concepts of other discipline and uses those all in managing the organization. 

 
3. Lower level management 

Lower level management is also known as supervisory level of management in which the 

supervisors and foremen and others like sales officers, accounts officers etc. take 

responsibilities of the implementation and control of the operational plans developed by the 

middle level managers. It is clear that the actual operations are performed in this level of 

management. This level is concerned with actual implementation and control of operational 

plans. 

Functions of lower level management 

i. To issue the orders and instruction to the workers. 

ii. To supervise and control the performance. 

iii. To plan the activities of the sections. 

iv. To direct and guide the workers about the work procedures. 

v. To provide on the job training to the workers. 

vi. To arrange necessary tools, equipment, materials for the workers and look after their 

proper maintenance. 

vii. To solve the problems of workers. 

viii. To develop sense of co-operation and high group spirit among the workers. 

ix. To advise the middle level about the work environment. 
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x. To inform the unsolved problems of the workers to the middle level management. 

 
 

Meaning and Concepts of Management: 

Meaning of Management 

It is realized that no definition of management has been universally accepted. It is very 

difficult to define management. Many experts and professionals have defined management in 

different ways. 

 

Generally, management means getting things done through others. Management is a process 

which includes planning, organizing, executing and controlling of different activities in order 

to achieve the objectives by using human and other resources. 

 
Concepts of Management 

The concept of management in different perspectives is as follows: 

 
I. Functional concept of Management: Functional concept of management states that, 

management is meant what manager does to accomplish the objective. 

II. Human Relation Concept of Management: Human relation concept of management 

states that management is meant to get things done through others to perform the 

organizational tasks or activities through people. This concept is concerned with an art 

of getting things done through others. 

III. Leadership And decision making concept Of Management: According to this 

concept, management is meant as an art and science of decision making and 

leadership. 

IV. Productive Concept of Management: According to the productive concept, 

management is considered as an art of increasing productivity. This concept 

emphasizes upon increasing in productivity. 

V. Integration Concept of Management: This concept is focused as management which 

coordinates the human and material resources. Integration concept of 

management assumes that organizational objectives could be achieved if human and 

other resources are well and effectively coordinated and integrated. 

Management Roles: 

A manager‘s role is very crucial in an organization. The success of organization depends upon 

manager‘s ability in utilizing the resources for achieving the pre determined goals. Henry Mintzberg 

suggested three areas where a manger has to work. 
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Interpersonal Roles 

 

1. The Figurehead: performs ceremonial duties. Examples: greeting visiting dignitaries, 

attending an employee’s wedding, taking an important customer to lunch. 

2. TheLeader:responsibilityfortheworkofsubordinates,motivatingandencouraging employees, 

exercising their formal authority. 

3. The Liaison: making contacts outside the vertical chain of command including peers in other 

companies or departments, and government and trade organization representatives. 

Informational Roles: 
 

4. The Monitor: scans the environment for new information to collect. 

5. The Disseminator: Passing on privileged information directly to subordinates. 

6. The Spokesperson: Sharing information with people outside their organization. Examples: a 

speech to a lobby or suggesting product modifications to suppliers. 

 

Decisional Roles 
 

7. The Entrepreneur: Seeks to improve the unit by initiating projects. 
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8. The Disturbance Handler: Responds involuntarily to pressures too severe to be 

ignored.Examples:aloomingstrike,amajorcustomergonebankrupt,orasupplier reneging on a 

contract. 

9. The Resource Allocator: Decides who gets what. 

10. The Negotiator: Committing organizational resource sin―real-time with the broad 

information available from their informational roles. 

 
Applying the Model for Improvement 

As a manager, you may tend to shy away from some of these roles that you don‘t favor i.e. you may 

tend to avoid monitoring and handling disturbances. Recognizing your strengths and weaknesses 

according to these ten roles can help you to develop your skills and knowledge and become a more 

well rounded manager. 

 
 

ACTIVITY: Think about how much time you spend on each role. Write down the ten roles on a 

piece of paper and score yourself from 1–5 on each role with 1 being ―Very skilled‖ to 5 being ―Not 

skilled at all.‖ Consult the list below for improvement tips in the roles where you scored the lowest. 

Tips for Improvement 

 

1. Figurehead: If you struggle wearing this hat, start with cultivating humility and empathy. 

Focus on using your energy to be a good role model and become more aware of your image 

and reputation and how you can consistently display model behavior. 

 

2. Leader: Anyone can be a leader, but not everyone can be an authentic leader who is respected 

by his or her team. The most important skill here to develop to improve is emotional 

intelligence. 

 

3. Liaison: Not everyone is comfortable being a networking ham, but it‘s part of the job. You 

can start by attending small networking events and work your way out. 

 
4. Monitor: The challenge of this aspect lies in its details. Become a better―skim me so you can 

scan through a lot of information and get to the big picture without experiencing information 

overload. It‘s also important in this area to keep up with industry news. 

5. Disseminator: If you struggle in this area, work on improving your communication skills. 

Knowing not only what to share, but how and with whom. If you have difficulty expressing 

things properly, engage a colleague to help in the beginning with proofreading or being a 

second pair of eyes as you adjust in this role. 

 

6. Spokesperson: This is an area where a lot of people feel challenged. Read blogs and  research 

how to deliver great presentations and how to deal with the media. Speak with your company 

leaders to discuss how the company‘s brand or image should be represented in the community. 

 

7. Entrepreneur: Work on problem solving and creativity skills or again, if this is not your 
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strength, employcolleagueswhoexcelherewithbrainstormingsessionsor―crazyideas‖ meetings. In 

addition, change management is a huge necessity in this area. 

 

8. Disturbance Handler: You can read up on how to handle team conflict to improve your 

conflict resolution skills, but it may also be helpful to constructively coach team members who 

have a habit of bringing emotion into the office. 

 

9. Resource Allocator: To wear this hat, prioritization is key. Take advantage of online tools 

and systems for this as well as budgeting tips. 

 

10. Negotiator: Read about Distributive Bargaining or Win-Win Negotiations to beef up your 

skills. Role playing can also be an important tool here to strengthen your ability to negotiate. 
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                           WEEK-3 

               Introduction to MS Excel 

MS EXCEL 

 

Microsoft Excel is a commercial spreadsheet application, written and distributed by Microsoft for 

Microsoft Windows and Mac OS X. At the time of developing these training modules, we have 

used Microsoft Excel version 2016. Microsoft Excel is a spreadsheet tool capable of performing 

calculations, analyzing data, and integrating information from different programs. 

GETTING STARTED WITH MS EXCEL: 

how to start an excel 2010 application in simple steps. Assuming you have Microsoft Office 2010 

installed in your PC, start the excel application following the below mentioned steps in your PC. 

Step 1 − Click on the Start button. 

 

 
 

Step 2 − Click on All Programs option from the menu. 
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Step 3 − Search for Microsoft Office from the sub menu and click it. 

 

Step 4 − Search for Microsoft Excel 2010 from the submenu and click it. 

 

 
 

This will launch the Microsoft Excel 2010 application and you will see the following excel window. 

 

Explore Window in Excel 2010 
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The following basic window appears when you start the excel application. Let us now understand the 

various important parts of this window. 

 
File Tab 

The File tab replaces the Office button from Excel 2007. You can click it to check the Back stage 

view, where you come when you need to open or save files, create new sheets, print a sheet, and do 

other file-related operations. 

Quick Access Toolbar 

You will find this toolbar just above the File tab and its purpose is to provide a convenient resting 

place for the Excel's most frequently used commands. You can customize this toolbar based on your 

comfort. 

Ribbon 

 

Ribbon contains commands organized in three components − 

• Tabs − They appear across the top of the Ribbon and contain groups of related commands. Home, 

Insert, Page Layout are the examples of ribbon tabs. 

• Groups − They organize related commands; each group name appears below the group on the 

Ribbon. For example, group of commands related to fonts or group of commands related to alignment 

etc. 
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• Commands − Commands appear within each group as mentioned above. 

Title Bar 

This lies in the middle and at the top of the window. Title bar shows the program and the sheet titles. 

Help 

The Help Icon can be used to get excel related help anytime you like. This provides nice tutorial on 

various subjects related to excel. 

Zoom Control 

Zoom control lets you zoom in for a closer look at your text. The zoom control consists of a slider 

that you can slide left or right to zoom in or out. The + buttons can be clicked to increase or decrease 

the zoom factor. 

View Buttons 

The group of three buttons located to the left of the Zoom control, near the bottom of the screen, lets 

you switch among excel's various sheet views. 

• Normal Layout view − This displays the page in normal view. 

• Page Layout view − This displays pages exactly as they will appear when printed. This gives a 

full screen look of the document. 

• Page Break view − This shows a preview of where pages will break when printed. 

Sheet Area 

The area where you enter data. The flashing vertical bar is called the insertion point and it represents 

the location where text will appear when you type. 

Row Bar 

Rows are numbered from 1 onwards and keep on increasing as you keep entering data. Maximum 

limit is 1,048,576 rows. 

Column Bar 

Columns are numbered from A onwards and keeps on increasing as you keep entering data. After Z, 

it will start the series of AA, AB and so on. Maximum limit is 16,384 columns. 

Status Bar 

This displays the current status of the active cell in the worksheet. A cell can be in either of the fours 

states (a) Ready mode which indicates that the worksheet is ready to accept user inpu (b) Edit mode 

indicates that cell is editing mode, if it is not activated the you can activate editing mode by double-

clicking on a cell (c) A cell enters into Enter mode when a user types data into a cell (d) Point mode 

triggers when a formula is being entered using a cell reference by mouse pointing or the arrow keys 

on the keyboard. 

Dialog Box Launcher 

This appears as a very small arrow in the lower-right corner of many groups on the Ribbon. Clicking 

this button opens a dialog box or task pane that provides more options about the group. 
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SHEET INFORMATION 

 

When you click Info option available in the first column, it displays the following information in the 

second column of the backstage view − 

• Compatibility Mode − If the sheet is not a native excel 2007/2010 sheet, a Convert button 

appears here, enabling you to easily update its format. Otherwise, this category does not appear. 

• Permissions − You can use this option to protect the excel sheet. You can set a password so that 

nobody can open your sheet, or you can lock the sheet so that nobody can edit your sheet. 

• Prepare for Sharing − This section highlights important information you should know about 

your sheet before you send it to others, such as a record of the edits you made as you developed the 

sheet. 

• Versions − If the sheet has been saved several times, you may be able to access previous versions 

of it from this section. 

 

SHEET PROPERTIES 

When you click Info option available in the first column, it displays various properties in the third 

column of the backstage view. These properties include sheet size, title, tags, categories etc. 

You can also edit various properties. Just try to click on the property value and if property is editable, 

then it will display a text box where you can add your text like title, tags, comments, Author. 

Exit Backstage View 

It is simple to exit from the Backstage View. Either click on the File tab or press the Esc button on 

the keyboard to go back to excel working mode. 

 

FEATURES AND USES OF MICROSOFT EXCEL: 

 

1 – You Can Insert a New Worksheets  

2 – Time Saving Shortcut Keys 

3 – Get Quick Sum of Numbers 

4 – Filtering Data 

5 – Paste special Feature 

6 – Insert Random Numbers 

7 – Insert Random Fraction Numbers 

8 – Goal Seek Analysis Tool 

9 – Insert Serial Number 
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                              WEEK-4 

                       Basics of Ms Excel 

 

Context Help in Excel 2010 

 

MS Excel provides context sensitive help on mouse over. To see context sensitive help for a particular 

Menu option, hover the mouse over the option for some time. Then you can see the context sensitive 

Help as shown below. 

 
Getting More Help 

For getting more help with MS Excel from Microsoft you can press F1 or by File → Help → 

Support → Microsoft Office Help. 

 

Insert Data in Excel 2010 
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In MS Excel, there are 1048576*16384 cells. MS Excel cell can have Text, Numeric value or 

formulas. An MS Excel cell can have maximum of 32000 characters. 

Inserting Data 

For inserting data in MS Excel, just activate the cell type text or number and press enter or 

Navigation keys. 

 
Inserting Formula 

For inserting formula in MS Excel go to the formula bar, enter the formula and then press enter or 

navigation key. See the screen-shot below to understand it. 

 

 
 

Modifying Cell Content 

 

For modifying the cell content just activate the cell, enter a new value and then press enter or 

navigation key to see the changes. See the screen-shot below to understand it. 
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Select Data in Excel 2010 

MS Excel provides various ways of selecting data in the sheet. Let us see those ways. 

Select with Mouse 

Drag the mouse over the data you want to select. It will select those cells as shown below. 

 
 

Select with Special 

If you want to select specific region, select any cell in that region.  

Pressing F5 will show the below dialogue box. 

 

Click on Special button to see the below dialogue box. Select current region from the radio buttons. 

Click on ok to see the current region selected. 
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As you can see in the below screen, the data is selected for the current region. 

 

Delete Data in Excel 2010 

MS Excel provides various ways of deleting data in the sheet. Let us see those ways. 

Delete with Mouse 

Select the data you want to delete. Right Click on the sheet. Select the delete option, to delete the 

data. 

 
Delete with Delete Key 
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Select the data you want to delete. Press on the Delete Button from the keyboard, it will delete the 

data. 

Selective Delete for Rows 

Select the rows, which you want to delete with Mouse click + Control Key. Then right click to show 

the various options. Select the Delete option to delete the selected rows. 

 

Move Data in Excel 2010 

Let us see how we can Move Data with MS Excel. 

Step 1 − Select the data you want to Move. Right Click and Select the cut option. 

 

Step 2 − Select the first cell where you want to move the data. Right click on it and paste the data. 

You can see the data is moved now. 

 

Rows & Columns in Excel 2010 
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Row and Column Basics 

MS Excel is in tabular format consisting of rows and columns. 

• Row runs horizontally while Column runs vertically. 

• Each row is identified by row number, which runs vertically at the left side of the sheet. 

• Each column is identified by column header, which runs horizontally at the top of the sheet. 

For MS Excel 2010, Row numbers ranges from 1 to 1048576; in total 1048576 rows, and Columns 

ranges from A to XFD; in total 16384 columns. 

Navigation with Rows and Columns 

Let us see how to move to the last row or the last column. 

• You can go to the last row by clicking Control + Down Navigation arrow. 

• You can go to the last column by clicking Control + Right Navigation arrow. 

 
Cell Introduction 

The intersection of rows and columns is called cell. 

Cell is identified with Combination of column header and row number. 

For example − A1, A2. 

 

Copy & Paste in Excel 2010 
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MS Excel provides copy paste option in different ways. The simplest method of copy paste is as 

below. 

Copy Paste 

• To copy and paste, just select the cells you want to copy. Choose copy option after right click or 

press Control + C. 

• Select the cell where you need to paste this copied content. Right click and select paste option or 

press Control + V. 

 

In this case, MS Excel will copy everything such as values, formulas, Formats, Comments and 

validation. MS Excel will overwrite the content with paste. If you want to undo this, press Control + 

Z from the keyboard. 

Copy Paste using Office Clipboard 

 

When you copy data in MS Excel, it puts the copied content in Windows and Office Clipboard.  

You can view the clipboard content by Home → Clipboard. 

View the clipboard content. Select the cell where you need to paste.  

Click on paste, to paste the content. 
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Copy Paste in Special way 

You may not want to copy everything in some cases. For example, you want to copy only Values or 

you want to copy only the formatting of cells. Select the paste special option as shown below. 

 

Below are the various options available in paste special. 

 

• All − Pastes the cell’s contents, formats, and data validation from the Windows Clipboard. 

• Formulas − Pastes formulas, but not formatting. 

• Values − Pastes only values not the formulas. 

• Formats − Pastes only the formatting of the source range. 

• Comments − Pastes the comments with the respective cells. 

• Validation − Pastes validation applied in the cells. 

• All using source theme − Pastes formulas, and all formatting. 

• All except borders − Pastes everything except borders that appear in the source range. 



 

34 | P a g e  

• Column Width − Pastes formulas, and also duplicates the column width of the copied cells. 

• Formulas & Number Formats − Pastes formulas and number formatting only. 

• Values & Number Formats –  

Pastes the results of formulas, plus the number. 

• Merge Conditional Formatting –  

This icon is displayed only when the copied cells contain conditional formatting. When clicked, 

it merges the copied conditional formatting with any conditional formatting in the destination 

range. 

• Transpose –  

Changes the orientation of the copied range. Rows become columns, and columns become rows. 

Any formulas in the copied range are adjusted so that they work properly when transposed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                           WEEK-5 
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Various Formatting Styles in Ms Excel 

 

BUILDING FORMULAS: 

 

Functions in Formula: 

Many formulas you create use available worksheet functions. These functions enable you to greatly 

enhance the power of your formulas and perform calculations that are difficult if you use only the 

operators. For example, you can use the LOG or SIN function to calculate the Logarithm or Sin ratio. 

You can’t do this complicated calculation by using the mathematical operators alone. 

Using Functions 

When you type = sign and then type any alphabet you will see the searched functions as below. 

 

Suppose you need to determine the largest value in a range. A formula can’t tell you the answer 

without using a function. We will use formula that uses the MAX function to return the largest value 

in the range B3:B8 as =MAX(A1:D100). 

 



 

36 | P a g e  

Another example of functions. Suppose you want to find if the cell of month is greater than 1900 then 

we can give Bonus to Sales representative. The we can achieve it with writing formula with IF 

functions as =IF(B9>1900,"Yes","No") 

 
Function Arguments 

In the above examples, you may have noticed that all the functions used parentheses. The information 

inside the parentheses is the list of arguments. 

Functions vary in how they use arguments. Depending on what it has to do, a function may use. 

• No arguments − Examples − Now(), Date(), etc. 

• One argument − UPPER(), LOWER(), etc. 

• A fixed number of arguments − IF(), MAX(), MIN(), AVERGAGE(), etc. 

• Infinite number of arguments 

• Optional arguments 

Built In Functions 

MS Excel has many built in functions, which we can use in our formula. To see all the functions by 

category, choose Formulas Tab » Insert Function. Then Insert function Dialog appears from which 

we can choose the function. 
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Functions by Categories 

Let us see some of the built in functions in MS Excel. 

• Text Functions 

o LOWER − Converts all characters in a supplied text string to lower case 

o UPPER − Converts all characters in a supplied text string to upper case 

o TRIM − Removes duplicate spaces, and spaces at the start and end of a text string 

o CONCATENATE − Joins together two or more text strings. 

o LEFT − Returns a specified number of characters from the start of a supplied text string. 

o MID − Returns a specified number of characters from the middle of a supplied text string 

o RIGHT − Returns a specified number of characters from the end of a supplied text string. 

o LEN − Returns the length of a supplied text string 

o FIND − Returns the position of a supplied character or text string from within a supplied text 

string (case-sensitive). 

• Date & Time 

o DATE − Returns a date, from a user-supplied year, month and day. 

o TIME − Returns a time, from a user-supplied hour, minute and second. 

o DATEVALUE − Converts a text string showing a date, to an integer that represents the date in 

Excel's date-time code. 

o TIMEVALUE − Converts a text string showing a time, to a decimal that represents the time in 

Excel. 

o NOW − Returns the current date & time. 

o TODAY − Returns today's date. 

• Statistical 

o MAX − Returns the largest value from a list of supplied numbers. 

o MIN − Returns the smallest value from a list of supplied numbers. 

o AVERAGE − Returns the Average of a list of supplied numbers. 

o COUNT − Returns the number of numerical values in a supplied set of cells or values. 

o COUNTIF − Returns the number of cells (of a supplied range), that satisfies a given criteria. 

o SUM − Returns the sum of a supplied list of numbers 

• Logical 

o AND − Tests a number of user-defined conditions and returns TRUE if ALL of the conditions 

evaluate to TRUE, or FALSE otherwise 

o OR − Tests a number of user-defined conditions and returns TRUE if ANY of the conditions 

evaluate to TRUE, or FALSE otherwise. 
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o NOT − Returns a logical value that is the opposite of a user supplied logical value or expression 

i.e. returns FALSE if the supplied argument is TRUE and returns TRUE if the supplied argument 

is FAL 

• Math & Trig 

o ABS − Returns the absolute value (i.e. the modulus) of a supplied number. 

o SIGN − Returns the sign (+1, -1 or 0) of a supplied number. 

o SQRT − Returns the positive square root of a given number. 

o MOD − Returns the remainder from a division between two supplied numbers. 

 

 AUTO SUM FEATURE IN MS EXCEL 

Excel The AutoSum feature makes it very easy to total rows and columns using 

the SUM worksheet function. 

There is a special command button on the standard toolbar that will allow you insert the SUM 

function very quickly. 

This command button is known as the AutoSum button. 

  
You can quickly enter the AVERAGE, COUNT, MAX or MIN functions by expanding the drop-

down menu. 

The "More Functions" button displays the (Insert > Function) dialog box. 

You can also use the shortcut key (Alt + =) to quickly sum the adjacent cells. 

Summing a vertical block of numbers 

Enter your numbers in a single column into consecutive cells. 

Select the cell directly below your list and press the AutoSum button on the standard toolbar. 

The SUM() function will be entered automatically and the cells which are going to be include are 

highlighted with a dotted line. Press Enter to confirm. 

  
The SUM function is inserted automatically and the corresponding range of cells is entered. 

Summing a horizontal block of numbers 

Enter your number in a single row into consecutive cells. 

Select the cell directly to the right of your list and press the AutoSum button on the standard 

https://bettersolutions.com/excel/functions/sum-function.htm
https://bettersolutions.com/excel/functions/average-function.htm
https://bettersolutions.com/excel/functions/count-function.htm
https://bettersolutions.com/excel/functions/max-function.htm
https://bettersolutions.com/excel/functions/min-function.htm
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toolbar. 

The SUM() function will be entered automatically and the cells which are going to be include are 

highlighted with a dotted line. Press Enter to confirm. 

  
 

 

Summing multiple columns of numbers 

If you have several columns of data and would like to sum all the individual columns separately you 

can highlight the cells before pressing the AutoSum button. 

Enter some numbers into the cell range "B2:C5". 

Highlight the cell range directly below "B6:C6" and press the AutoSum button. 

  
 

 

Summing multiple rows of numbers 

If you have several rows of data it is also possible to sum all the individual rows (or columns) 

separately. 

Enter some numbers into the cell range "B2:E3". 

Highlight the cell range directly on the left "F2:F3" and press the AutoSum button. 

 
 

Important 

If the suggested range of cells is not correct you can just drag the range to the correct cells. 

AutoSum will only include cells that contain a value. If any empty cells appears in a column or row 

then only the cells after this will be included. 

(Alt + =) - Enters the SUM() function using the adjacent range of cells. 

https://bettersolutions.com/excel/functions/sum-function.htm
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CONDITIONAL FORMATTING 

MS Excel 2010 Conditional Formatting feature enables you to format a range of values so that the 

values outside certain limits, are automatically formatted. 

Choose Home Tab » Style group » Conditional Formatting dropdown. 

Various Conditional Formatting Options 

• Highlight Cells Rules − It opens a continuation menu with various options for defining the 

formatting rules that highlight the cells in the cell selection that contain certain values, text, or dates, 

or that have values greater or less than a particular value, or that fall within a certain ranges of values. 

Suppose you want to find cell with Amount 0 and Mark them as red.Choose Range of cell » Home 

Tab » Conditional Formatting DropDown » Highlight Cell Rules » Equal To. 

 

After Clicking ok, the cells with value zero are marked as red. 

 

• Top/Bottom Rules − It opens a continuation menu with various options for defining the 

formatting rules that highlight the top and bottom values, percentages, and above and below average 

values in the cell selection. 

Suppose you want to highlight the top 10% rows you can do this with these Top/Bottom rules. 
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• Data Bars − It opens a palette with different color data bars that you can apply to the cell selection 

to indicate their values relative to each other by clicking the data bar thumbnail. 

With this conditional Formatting data Bars will appear in each cell. 

 

• Color Scales − It opens a palette with different three- and two-colored scales that you can apply 

to the cell selection to indicate their values relative to each other by clicking the color scale thumbnail. 

See the below screenshot with Color Scales, conditional formatting applied. 
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• Icon Sets − It opens a palette with different sets of icons that you can apply to the cell selection 

to indicate their values relative to each other by clicking the icon set. 

See the below screenshot with Icon Sets conditional formatting applied. 

 

• New Rule − It opens the New Formatting Rule dialog box, where you define a custom conditional 

formatting rule to apply to the cell selection. 

• Clear Rules − It opens a continuation menu, where you can remove the conditional formatting 

rules for the cell selection by clicking the Selected Cells option, for the entire worksheet by clicking 

the Entire Sheet option, or for just the current data table by clicking the This Table option. 

• Manage Rules − It opens the Conditional Formatting Rules Manager dialog box, where you edit 

and delete particular rules as well as adjust their rule precedence by moving them up or down in the 

Rules list box. 

 

WORKING WITH CHARTS 

To create a line chart, execute the following steps. 

 

1. Select the rangeA1:D7. 
 

2. On the Insert tab, in the Charts group, choose Line, and select Line withMarkers. 
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Result: 
 

Change Chart Type 

You can easily change to a different type of chart at any time. 
 

1. Select thechart. 
 

2. On the Insert tab, in the Charts group, choose Column, and select Clustered Column. 
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                                   WEEK-6 

                      Working with text and lookup functions 
TEXT FUNCTIONS 

The data that you obtain from different sources many not be in a form ready for analysis. In this chapter, 

you will understand how to prepare your data that is in the form of text for analysis. 

Initially, you need to clean the data. Data cleaning includes removing unwanted characters from text. 

Next, you need to structure the data in the form you require for further analysis. You can do the same 

by − 

• Finding required text patterns with the text functions. 

• Extracting data values from text. 

• Formatting data with text functions. 

• Executing data operations with the text functions. 

Removing Unwanted Characters from Text 

When you import data from another application, it can have nonprintable characters and/or excess 

spaces. The excess spaces can be − 

• leading spaces, and/or 

• extra spaces between words. 

If you sort or analyze such data, you will get erroneous results. 

 

Consider the following example − 

 

This is the raw data that you have obtained on product information containing the Product ID, Product 

description and the price. The character “|” separates the field in each row. 

When you import this data into Excel worksheet, it looks as follows − 
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As you observe, the entire data is in a single column. You need to structure this data to perform data 

analysis. However, initially you need to clean the data. 

You need to remove any nonprintable characters and excess spaces that might be present in the data. 

You can use the CLEAN function and TRIM function for this purpose. 

S.No. Function & Description 

1. CLEAN 

Removes all nonprintable characters from text 

2. 
TRIM 

Removes spaces from text 

• Select the Cells C3 – C11. 

• Type =TRIM (CLEAN (B3)) and then press CTRL + Enter. 

The formula is filled in the cells C3 – C11. 

 

The result will be as shown below − 
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Finding required Text Patterns with the Text Functions 

To structure your data, you might have to do certain Text Pattern matching based on which you can 

extract the Data Values. Some of the Text Functions that are useful for this purpose are − 

S.No. Function & Description 

1. EXACT 

Checks to see if two text values are identical 

2. 
FIND 

Finds one text value within another (case-sensitive) 

3. 
SEARCH 

Finds one text value within another (not case-sensitive) 

 
LOOKUP FUNCTIONS 
 

You can use Excel functions to − 

• Find values in a range of data - VLOOKUP and HLOOKUP 

• Obtain a value or the reference to a value from within a table or range - INDEX 

• Obtain the relative position of a specified item in a range of cells - MATCH 

You can also combine these functions to get the required results based on the inputs you have. 

Using VLOOKUP Function 

The syntax of the VLOOKUP function is 

VLOOKUP (lookup_value, table_array, col_index_num, [range_lookup]) 

Where 
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• lookup_value − is the value you want to look up. Lookup_value can be a value or a reference to 

a cell. Lookup_value must be in the first column of the range of cells you specify in table_array 

• table_array − is the range of cells in which the VLOOKUP will search for the lookup_value and 

the return value. table_array must contain 

o the lookup_value in the first column, and 

o the return value you want to find 

Note − The first column containing the lookup_value can either be sorted in ascending order or not. 

However, the result will be based on the order of this column. 

• col_index_num − is the column number in the table_array that contains the return value. The 

numbers start with 1 for the left-most column of table-array 

• range_lookup − is an optional logical value that specifies whether you want VLOOKUP to find 

an exact match or an approximate match. range_lookup can be 

o omitted, in which case it is assumed to be TRUE and VLOOKUP tries to find an approximate 

match 

o TRUE, in which case VLOOKUP tries to find an approximate match. In other words, if an exact 

match is not found, the next largest value that is less than lookup_value is returned 

o FALSE, in which case VLOOKUP tries to find an exact match 

o 1, in which case it is assumed to be TRUE and VLOOKUP tries to find an approximate match 

o 0, in which case it is assumed to be FALSE and VLOOKUP tries to find an exact match 

Note − If range_lookup is omitted or TRUE or 1, VLOOKUP works correctly only when the first 

column in table_array is sorted in ascending order. Otherwise, it may result in incorrect values. In such 

a case, use FALSE for range_lookup. 

Using VLOOKUP Function with range_lookup TRUE 

Consider a list of student marks. You can obtain the corresponding grades with VLOOKUP from an 

array containing the marks intervals and pass category. 

table_array − 

 

Note that the first column marks based on which the grades are obtained is sorted in ascending order. 

Hence, using TRUE for range_lookup argument you can get approximate match that is what is required. 
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Name this array as Grades. 

It is a good practice to name arrays in this way so that you need not remember the cell ranges. Now, 

you are ready to look up the grade for the list of marks you have as follows − 

 

As you can observe, 

• col_index_num − indicates the column of the return value in table_array is 2 

• the range_lookup is TRUE 

o The first column containing the lookup value in the table_array grades is in ascending order. 

Hence, the results will be correct. 

o You can get the return value for approximate matches also. i.e. VLOOKUP computes as follows 

− 

Marks Pass Category 

< 35 Fail 

>= 35 and 

< 50 

Third Class 

>= 50 and 

< 60 

Second Class 
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>=60 and < 

75 

First Class 

>= 75 First Class with Distinction 
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                              WEEK-7 

Working with Functions  

BUILT IN FUNCTIONS 

MS Excel has many built in functions, which we can use in our formula. To see all the functions by 

category, choose Formulas Tab » Insert Function. Then Insert function Dialog appears from which 

we can choose the function. 

 
Functions by Categories 

Let us see some of the built in functions in MS Excel. 

• Text Functions 

o LOWER − Converts all characters in a supplied text string to lower case 

o UPPER − Converts all characters in a supplied text string to upper case 

o TRIM − Removes duplicate spaces, and spaces at the start and end of a text string 

o CONCATENATE − Joins together two or more text strings. 

o LEFT − Returns a specified number of characters from the start of a supplied text string. 

o MID − Returns a specified number of characters from the middle of a supplied text string 

o RIGHT − Returns a specified number of characters from the end of a supplied text string. 

o LEN − Returns the length of a supplied text string 

o FIND − Returns the position of a supplied character or text string from within a supplied text 

string (case-sensitive). 
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• Date & Time 

o DATE − Returns a date, from a user-supplied year, month and day. 

o TIME − Returns a time, from a user-supplied hour, minute and second. 

o DATEVALUE − Converts a text string showing a date, to an integer that represents the date in 

Excel's date-time code. 

o TIMEVALUE − Converts a text string showing a time, to a decimal that represents the time in 

Excel. 

o NOW − Returns the current date & time. 

o TODAY − Returns today's date. 

• Statistical 

o MAX − Returns the largest value from a list of supplied numbers. 

o MIN − Returns the smallest value from a list of supplied numbers. 

o AVERAGE − Returns the Average of a list of supplied numbers. 

o COUNT − Returns the number of numerical values in a supplied set of cells or values. 

o COUNTIF − Returns the number of cells (of a supplied range), that satisfies a given criteria. 

o SUM − Returns the sum of a supplied list of numbers 

• Logical 

o AND − Tests a number of user-defined conditions and returns TRUE if ALL of the conditions 

evaluate to TRUE, or FALSE otherwise 

o OR − Tests a number of user-defined conditions and returns TRUE if ANY of the conditions 

evaluate to TRUE, or FALSE otherwise. 

o NOT − Returns a logical value that is the opposite of a user supplied logical value or expression 

i.e. returns FALSE if the supplied argument is TRUE and returns TRUE if the supplied argument is 

FAL 

• Math & Trig 

o ABS − Returns the absolute value (i.e. the modulus) of a supplied number. 

o SIGN − Returns the sign (+1, -1 or 0) of a supplied number. 

o SQRT − Returns the positive square root of a given number. 

o MOD − Returns the remainder from a division between two supplied numbers. 
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                                WEEK-8 

                 Data Analysis with Ms Excel 

DATA ANALYSIS - OVERVIEW 

Data Analysis is a process of inspecting, cleaning, transforming and modeling data with the goal of 

discovering useful information, suggesting conclusions and supporting decision-making 

. 

Types of Data Analysis 

Several data analysis techniques exist encompassing various domains such as business, science, 

social science, etc. with a variety of names. The major data analysis approaches are − 

• Data Mining 

• Business Intelligence 

• Statistical Analysis 

• Predictive Analytics 

• Text Analytics 

Data Mining 

Data Mining is the analysis of large quantities of data to extract previously unknown, interesting 

patterns of data, unusual data and the dependencies. Note that the goal is the extraction of patterns 

and knowledge from large amounts of data and not the extraction of data itself. 

Data mining analysis involves computer science methods at the intersection of the artificial 

intelligence, machine learning, statistics, and database systems. 

The patterns obtained from data mining can be considered as a summary of the input data that can be 

used in further analysis or to obtain more accurate prediction results by a decision support system. 

Business Intelligence 

Business Intelligence techniques and tools are for acquisition and transformation of large amounts of 

unstructured business data to help identify, develop and create new strategic business opportunities. 

The goal of business intelligence is to allow easy interpretation of large volumes of data to identify 

new opportunities. It helps in implementing an effective strategy based on insights that can provide 

businesses with a competitive market-advantage and long-term stability. 

Statistical Analysis 

Statistics is the study of collection, analysis, interpretation, presentation, and organization of data. 

In data analysis, two main statistical methodologies are used − 

• Descriptive statistics − In descriptive statistics, data from the entire population or a sample is 

summarized with numerical descriptors such as − 

o Mean, Standard Deviation for Continuous Data 

o Frequency, Percentage for Categorical Data 
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• Inferential statistics − It uses patterns in the sample data to draw inferences about the represented 

population or accounting for randomness. These inferences can be − 

o answering yes/no questions about the data (hypothesis testing) 

o estimating numerical characteristics of the data (estimation) 

o describing associations within the data (correlation) 

o modeling relationships within the data (E.g. regression analysis) 

Predictive Analytics 

Predictive Analytics use statistical models to analyze current and historical data for forecasting 

(predictions) about future or otherwise unknown events. In business, predictive analytics is used to 

identify risks and opportunities that aid in decision-making. 

Text Analytics 

Text Analytics, also referred to as Text Mining or as Text Data Mining is the process of deriving 

high-quality information from text. Text mining usually involves the process of structuring the input 

text, deriving patterns within the structured data using means such as statistical pattern learning, and 

finally evaluation and interpretation of the output. 

Data Analysis Process 

Data Analysis is defined by the statistician John Tukey in 1961 as "Procedures for analyzing data, 

techniques for interpreting the results of such procedures, ways of planning the gathering of data to 

make its analysis easier, more precise or more accurate, and all the machinery and results of 

(mathematical) statistics which apply to analyzing data.” 

Thus, data analysis is a process for obtaining large, unstructured data from various sources and 

converting it into information that is useful for − 

• Answering questions 

• Test hypotheses 

• Decision-making 

• Disproving theories 

Data Analysis with Excel 

Microsoft Excel provides several means and ways to analyze and interpret data. The data can be from 

various sources. The data can be converted and formatted in several ways. It can be analyzed with 

the relevant Excel commands, functions and tools - encompassing Conditional Formatting, Ranges, 

Tables, Text functions, Date functions, Time functions, Financial functions, Subtotals, Quick 

Analysis, Formula Auditing, Inquire Tool, What-if Analysis, Solvers, Data Model, PowerPivot, 

PowerView, PowerMap, etc. 

You will be learning these data analysis techniques with Excel as part of two parts − 

• Data Analysis with Excel and 

• Advanced Data Analysis with Excel 
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WHAT - IF ANALYSIS - DATA TABLES, SCENARIO MANAGER, GOAL SEEK 

 

What-if analysis is the process of changing the values in cells to see how those changes will affect 

the outcome of formulas on the worksheet. You can use several different sets of values in one or more 

formulas to explore all the various results. 

What-if analysis is useful in many situations while doing data analysis. For example − 

• You can propose different budgets based on revenue. 

• You can predict the future values based on the given historical values. 

• If you are expecting a certain value as the result from a formula, you can find different sets of 

input values that produce the desired result. 

Excel provides you with the following What-if analysis tools that can be used based on your data 

analysis needs − 

• Data Tables 

• Scenario Manager 

• Goal Seek 

Data Tables and Scenarios take sets of input values and project forward to determine possible results. 

Goal seek differs from Data Tables and Scenarios in that it takes a result and projects backwards to 

determine possible input values that produce that result. 

In this chapter, you will understand the possible situations where you can use the Whatif Analysis 

tools. For details on usage of these tools, refer to the later chapters in this tutorial. 

Data Tables 

A Data Table is a range of cells in which you can change values in some of the cells and come up 

with different answers to a problem. For example, you might want to know how much loan you can 

afford for a home by analyzing different loan amounts and interest rates. You can put these different 

values along with the PMT function in a Data Table and get the desired result. 

A Data Table works only with one or two variables, but it can accept many different values for those 

variables. 

For the details on Data Tables, refer to the chapter – What-If Analysis with Data Tables in this 

tutorial. 

Scenario Manager 

A scenario is a set of values that Excel saves and can substitute automatically in cells on a worksheet. 

The key features are − 

• You can create and save different groups of values on a worksheet and then switch to any of these 

new scenarios to view different results. 

• A scenario can have multiple variables, but it can accommodate only up to 32 values. 

https://www.tutorialspoint.com/excel_data_analysis/what_if_analysis_with_data_tables.htm
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• You can also create a scenario summary report, which combines all the scenarios on one 

worksheet. For example, you can create several different budget scenarios that compare various 

possible income levels and expenses, and then create a report that lets you compare the scenarios 

side-by-side. 

• Scenario Manager is a dialog box that allows you to save the values as a scenario and name the 

scenario. 

For the details on Scenarios, refer to the chapter – What-If Analysis with Scenario Manager in this 

tutorial. 

Goal Seek 

Goal Seek is useful if you know the result that you want from a formula, but not sure what input value 

the formula needs, to get that result. For example, if you want to borrow a loan and you know the 

loan amount, tenure of loan and the EMI that you can pay, you can use Goal Seek to find the interest 

rate at which you can avail the loan. 

Goal Seek can be used only with one variable input value. If you have more than one variable for 

input values, you can use the Solver add-in. 

For details on the usage of Goal Seek, refer to the chapter – What-If Analysis with Goal Seek in this 

tutorial. 

Solver 

Solver comes with Excel as an add-in. You can use Solver to find an optimal value for a formula in 

a cell called the target cell on a worksheet. 

Solver works with a group of cells that are related to the formula in the target cell. Solver adjusts the 

values in the adjustable cells that you specify, to produce the result that you specify, from the target 

cell formula. 

What-If Analysis with Data Tables 

With a Data Table in Excel, you can easily vary one or two inputs and perform What-if analysis. A 

Data Table is a range of cells in which you can change values in some of the cells and come up with 

different answers to a problem. 

There are two types of Data Tables − 

• One-variable Data Tables 

• Two-variable Data Tables 

If you have more than two variables in your analysis problem, you need to use Scenario Manager 

Tool of Excel. For details, refer to the chapter – What-If Analysis with Scenario Manager in this 

tutorial. 

One-variable Data Tables 

A one-variable Data Table can be used if you want to see how different values of one variable in one 

or more formulas will change the results of those formulas. In other words, with a one-variable Data 

Table, you can determine how changing one input changes any number of outputs. You will 

understand this with the help of an example. 

https://www.tutorialspoint.com/excel_data_analysis/what_if_analysis_with_scenario_manager.htm
https://www.tutorialspoint.com/excel_data_analysis/what_if_analysis_with_goal_seek.htm
https://www.tutorialspoint.com/excel_data_analysis/what_if_analysis_with_scenario_manager.htm
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                        WEEK-9 

Creation of Various Charts in Ms Excel 

 
 
   CREATING PIVOT TABLES AND PIVOT CHARTS 

PIVOT TABLES 

A pivot table is essentially a dynamic summary report generated from a database. The database can 

reside in a worksheet (in the form of a table) or in an external data file. A pivot table can help 

transform endless rows and columns of numbers into a meaningful presentation of the data. Pivot 

tables are very powerful tool for summarized analysis of the data. 

Pivot tables are available under Insert tab » PivotTable dropdown » PivotTable. 

Pivot Table Example 

Now, let us see Pivot table with the help of example. Suppose you have huge data of voters and you 

want to see the summarized data of voter Information per party, then you can use the Pivot table for 

it. Choose Insert tab » Pivot Table to insert pivot table. MS Excel selects the data of the table. You 

can select the pivot table location as existing sheet or new sheet. 

 

This will generate the Pivot table pane as shown below. You have various options available in the 

Pivot table pane. You can select fields for the generated pivot table. 
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Column labels − A field that has a column orientation in the pivot table. Each item in the field 

occupies a column. 

Report Filter − You can set the filter for the report as year, then data gets filtered as per the year. 

Row labels − A field that has a row orientation in the pivot table. Each item in the field occupies a 

row. 

Values area − The cells in a pivot table that contain the summary data. Excel offers several ways to 

summarize the data (sum, average, count, and so on). 

After giving input fields to the pivot table, it generates the pivot table with the data as shown below. 

 

 

Pivot Charts 

A pivot chart is a graphical representation of a data summary, displayed in a pivot table. A pivot chart 

is always based on a pivot table. Although Excel lets you create a pivot table and a pivot chart at the 

same time, you can’t create a pivot chart without a pivot table. All Excel charting features are 

available in a pivot chart. 

Pivot charts are available under Insert tab » PivotTable dropdown » PivotChart. 

Pivot Chart Example 

Now, let us see Pivot table with the help of an example. Suppose you have huge data of voters and 

you want to see the summarized view of the data of voter Information per party in the form of charts, 

then you can use the Pivot chart for it. Choose Insert tab » Pivot Chart to insert the pivot table. 
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MS Excel selects the data of the table. You can select the pivot chart location as an existing sheet or 

a new sheet. Pivot chart depends on automatically created pivot table by the MS Excel. You can 

generate the pivot chart in the below screen-shot. 
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                          WEEK-10 

              LaTeX FORMATTING 
INTRODUCTION TO LATEX 
 

LATEX (pronounced LAY-tek or LAH-tek) is a tool used to create professional-looking 

documents. It is based on the WYSIWYM (what you see is what you mean) idea, meaning you only 

have focus on the contents of your document and the computer will take care of the formatting. 

Instead of spacing out text on a page to control formatting, as with Microsoft Word or LibreOffice 

Writer, users can enter plain text and let LATEX take care of the rest. 

 

LATEX is used all over the world for scientific documents, books, as well as many other forms of 

publishing. Not only can it create beautifully typeset documents, but it allows users to very quickly 

tackle the more complicated parts of typesetting, such as inputting mathematics, creating tables of 

contents, referencing and creating bibliographies, and having a consistent layout across all sections. 

Due to the huge number of open source packages available (more on this later), the possibilities 

with LATEX are endless. These packages allow users to do even more with LATEX, such as add 

footnotes, draw schematics, create tables etc. 

One of the most important reasons people use LATEX is that it separates the content of the 

document from the style. This means that once you have written the content of your document, we 

can change its appearance with ease. Similarly, you can create one style of document which can be 

used to standardise the appearance of many different documents. This allows scientific journals to 

create templates for submissions. These templates have a pre-made layout meaning that only the 

content needs to be added. In fact there are hundreds of templates available for everything from 

CVs to slideshows. 

WRITING YOUR FIRST PIECE OF LATEX 

The first step is to create a new LATEX project. You can do this on your own computer by creating 

a new .tex file 

\documentclass{article} 

  

\begin{document} 

First document. This is a simple example, with no  

extra parameters or packages included. 

\end{document} 

 

You can see that LATEX has already taken care of the first piece of formatting for you, by 

indenting the first line of the paragraph. 

 The first line of code declares the type of document, known as the class. The class controls the 

overall appearance of the document. Different types of documents will require different classes i.e. 

a CV/resume will require a different class than a scientific paper. In this case, the class is article, 

the simplest and most common LATEX class. Other types of documents you may be working on 

may require different classes such as book or report. 

https://www.sharelatex.com/templates
https://www.overleaf.com/learn/File:Firstdocsmall.PNG
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After this, you write the content of our document, enclosed inside 

the \begin{document} and \end{document} tags. This is known as the body of the document. You 

can start writing here and make changes to the text if you wish. To see the result of these changes in 

the PDF you have to compile the document. To do this in Overleaf, simply hit Recompile. (You 

can also set your project to automatically recompile when you edit your files, by clicking on the 

small arrow next to the 'Recompile button and set 'Auto Compile to 'On.) 

If you are using a basic text editor such as gedit, emacs, vim, sublime, notepad etc., you will have to 

compile the document manually. To do this, simply run pdflatex <your document> in your 

computers terminal/command line. See here for more information on how to do this. 

If you are using a dedicated LaTeX editor such as TeXmaker or TeXworks, simply hit 

the Recompile button. Consult the programs documentation if you are unsure of where this is. 

Now that you have learnt how to add content to our document, the next step is to give it a title. To 

do this, we must talk briefly about the preamble. 

THE PREAMBLE OF A DOCUMENT 

In the previous example the text was entered after the \begin{document} command. Everything in 

your .tex file before this point is called the preamble. In the preamble you define the type of 

document you are writing, the language you are writing in, the packages you would like to use 

(more on this later) and several other elements. For instance, a normal document preamble would 

look like this: 

\documentclass[12pt, letterpaper]{article} 

\usepackage[utf8]{inputenc} 

Below a detailed description of each line: 

\documentclass[12pt, letterpaper]{article} 

As said before, this defines the type of document. Some additional parameters included in the 

square brackets brackets can be passed to the command. These parameters must be comma-

separated. In the example, the extra parameters set the font size (12pt) and the paper size 

(letterpaper). Of course other font sizes (9pt, 11pt, 12pt) can be used, but if none is specified, the 

default size is 10pt. As for the paper size other possible values are a4paper and legalpaper; see the 

article about Page size and margins for more details about this. 

\usepackage[utf8]{inputenc} 

This is the encoding for the document. It can be omitted or changed to another encoding but utf-8 is 

recommended. Unless you specifically need another encoding, or if you are unsure about it, add this 

line to the preamble. 

Adding a title, author and date 

To add a title, author and date to our document, you must add three lines to the preamble (NOT the 

main body of the document). These lines are 

\title{First document} 

This is the title. 

\author{Hubert Farnsworth} 

https://en.wikibooks.org/wiki/LaTeX/Basics#Compilation
https://en.wikibooks.org/wiki/LaTeX/Installation#Editors
https://www.overleaf.com/learn/Page_size_and_margins
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Here you put the name of the Author(s) and, as a optional parameter, you can add the next 

command: 

\thanks{funded by the Overleaf team} 

This can be added after the name of the autor, inside the braces of the title command. It will add a 

superscript and a footnote with the text inside the braces. Useful if you need to thank an institution 

in your article. 

\date{February 2014} 

You can enter the date manually or use the command \today so the date will be updated 

automatically at the time you compile your document 

With these lines added, your preamble should look something like this 

\documentclass[12pt, letterpaper, twoside]{article} 

\usepackage[utf8]{inputenc} 

  

\title{First document} 

\author{Hubert Farnsworth \thanks{funded by the Overleaf team}} 

\date{February 2017} 

Now that you have given your document a title, author and date, you can print this information on 

the document with the \maketitle command. This should be included in the body of the document 

at the place you want the title to be printed. 

\begin{document} 

  

\maketitle 

  

We have now added a title, author and date to our first \LaTeX{} document! 

  

\end{document} 

 

Adding comments 

As with any code you are writing, it can often be useful to include comments. Comments are pieces 

of text you can include in the document which will not be printed, and will not affect the document 

in any way. They are useful for organizing your work, taking notes, or commenting out 

lines/sections when debugging. To make a comment in LATEX, simply write a % symbol at the 

beginning of the line as shown below: 

\begin{document} 

  

\maketitle 

https://www.overleaf.com/learn/File:Learnlatex1.PNG
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We have now added a title, author and date to our first \LaTeX{} document! 

  

% This line here is a comment. It will not be printed in the document. 

  

\end{document} 

 

Bold, italics and underlining 

We will now look at some simple text formatting commands. 

• Bold: Bold text in LaTeX is written with the \textbf{...} command. 

• Italics: Italicised text in LaTeX is written with the \textit{...} command. 

• Underline: Underlined text in LaTeX is written with the \underline{...} command. 

An example of each of these in action is shown below: 

Some of the \textbf{greatest} 

discoveries in \underline{science}  

were made by \textbf{\textit{accident}}. 

 

Another very useful command is the \emph{...} command. What the \emph command actually does 

with its argument depends on the context - inside normal text the emphasized text is italicized, but 

this behaviour is reversed if used inside an italicized text- see example below: 

Some of the greatest \emph{discoveries}  

in science  

were made by accident. 

  

\textit{Some of the greatest \emph{discoveries}  

in science  

were made by accident.} 

  

\textbf{Some of the greatest \emph{discoveries}  

in science  

were made by accident.} 

https://www.overleaf.com/learn/File:Learnlatex1.PNG
https://www.overleaf.com/learn/File:Biu1.png
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Moreover, some packages, e.g. Beamer, change the behaviour of \emph command. 

Adding images 

We will now look at how to add images to a LATEX document. On Overleaf, you will first have 

to upload the images. 

Below is a example on how to include a picture. 

\documentclass{article} 

\usepackage{graphicx} 

\graphicspath{ {images/} } 

  

\begin{document} 

The universe is immense and it seems to be homogeneous,  

in a large scale, everywhere we look at. 

  

\includegraphics{universe} 

  

There's a picture of a galaxy above 

\end{document} 

 

LATEX can not manage images by itself, so you will need to use a package. Packages can be used 

to change the default look of your LATEX document, or to allow more functionalities. In this case, 

you need to include an image in our document, so you should use the graphicx package. This 

package gives new commands, \includegraphics{...} and \graphicspath{...}. To use 

the graphicx package, include the following line in you preamble: \usepackage{graphicx} 

The command \graphicspath{ {images/} } tells LATEX that the images are kept in a folder 

named images under the current directory. 

The \includegraphics{universe} command is the one that actually included the image in the 

document. Here universe is the name of the file containing the image without the extension, 

then universe.PNG becomes universe. The file name of the image should not contain white spaces 

nor multiple dots. 

https://www.overleaf.com/learn/Beamer
https://www.overleaf.com/learn/Including_images_in_ShareLaTeX
https://www.overleaf.com/learn/File:Biu5.png
https://www.overleaf.com/learn/File:InsertingImagesEx1.png
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Note: The file extension is allowed to be included, but it's a good idea to omit it. If the file 

extension is omitted it will prompt LaTeX to search for all the supported formats. It is also usually 

recommended to use lowercase letters for the file extension when uploading image files. For more 

details see the section about generating high resolution and low resolution images. 

 

Captions, labels and references 

Images can be captioned, labelled and referenced by means of the figure environment as shown 

below: 

\begin{figure}[h] 

    \centering 

    \includegraphics[width=0.25\textwidth]{mesh} 

    \caption{a nice plot} 

    \label{fig:mesh1} 

\end{figure} 

  

As you can see in the figure \ref{fig:mesh1}, the  

function grows near 0. Also, in the page \pageref{fig:mesh1}  

is the same example. 

 

There are three important commands in the example: 

• \caption{a nice plot}: As you may expect this command sets the caption for the figure. If you 

create a list of figures this caption will be used there. You can place it above or below the figure. 

• \label{fig:mesh1}: If you need to refer the image within your document, set a label with this 

command. The label will number the image, and combined with the next command will allow you 

to reference it. 

• \ref{fig:mesh1}: This code will be substituted by the number corresponding to the referenced 

figure. 

When placing images in a LATEX document, we should always put them inside 

a figure environment or similar so that LATEX will position the image in a way that fits in with the 

rest of your text. 

Note: If you are using captions and references on your own computer, you will 

have to compile the document twice for the references to work.

https://www.overleaf.com/learn/latex/Learn_LaTeX_in_30_minutes#Generating_high-res_and_low-res_images
https://www.overleaf.com/learn/File:InsertingImages.PNG
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                                 WEEK-11 

              Various Formatting Styles In Latex 

Creating lists in LATEX 

Lists are very simple to create in LATEX. You can create lists using different list environments. 

Environments are sections of our document that you want to present in a different way to the rest of 

the document. They start with a \begin{...} command and end with an \end{...} command. 

There are two main different types of lists, ordered lists and unordered lists. Each will use a 

different environment. 

Unordered lists 

Unordered lists are produced by the itemize environment. Each entry must be preceded by the 

control sequence \item as shown below. 

\begin{itemize} 

  \item The individual entries are indicated with a black dot, a so-called bullet. 

  \item The text in the entries may be of any length. 

\end{itemize} 

 

By default the individual entries are indicated with a black dot, so-called bullet. The text in the 

entries may be of any length. 

Ordered lists 

Ordered list have the same syntax inside a different environment. We make ordered lists using 

the enumerate environment: 

\begin{enumerate} 

  \item This is the first entry in our list 

  \item The list numbers increase with each entry we add 

\end{enumerate} 

 

As with unordered lists, each entry must be preceded by the control sequence \item, which will 

automatically generate the number labelling the item. The enumerate labels consists of sequential 

numbers starting at one. 

Adding math to LATEX 

https://www.overleaf.com/learn/File:Itemize.png
https://www.overleaf.com/learn/File:Enumerate.png
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One of the main advantages of LATEX is the ease at which mathematical expressions can be 

written. LATEX allows two writing modes for mathematical expressions: the inline mode and 

the display mode. The first one is used to write formulas that are part of a text. The second one is 

used to write expressions that are not part of a text or paragraph, and are therefore put on separate 

lines. Let's see an example of the inline mode: 

In physics, the mass-energy equivalence is stated  

by the equation $E=mc^2$, discovered in 1905 by Albert Einstein. 

 

To put your equations in inline mode use one of these delimiters: \( ... \), $ ... $ or \begin{math} ... 

\end{math}. They all work and the choice is a matter of taste. 

The displayed mode has two versions: numbered and unnumbered. 

The mass-energy equivalence is described by the famous equation 

  

\[ E=mc^2 \] 

  

discovered in 1905 by Albert Einstein.  

In natural units ($c = 1$), the formula expresses the identity 

  

\begin{equation} 

E=m 

\end{equation} 

 

To print your equations in display mode use one of these delimiters: \[ ... \], \begin{displaymath} 

... \end{displaymath} or \begin{equation} ... \end{equation}. $$ ... $$ is discouraged as it can 

give inconsistent spacing, and may not work well with some math packages. 

Important Note: equation* environment is provided by an external package, consult 

the amsmath article. 

  Open an example in Overleaf 

Many math mode commands require the amsmath package, so be sure to include it when writing 

math. An example is shown below of some basic math mode commands. 

Subscripts in math mode are written as $a_b$ and superscripts are written as $a^b$. These can be 

combined an nested to write expressions such as 

  

\[ T^{i_1 i_2 \dots i_p}_{j_1 j_2 \dots j_q} = T(x^{i_1},\dots,x^{i_p},e_{j_1},\dots,e_{j_q}) \] 

  

We write integrals using $\int$ and fractions using $\frac{a}{b}$. Limits are placed on integrals 

using superscripts and subscripts: 

https://texfaq.org/FAQ-dolldoll
https://www.overleaf.com/learn/Aligning_equations
https://www.sharelatex.com/project/new/template?zipUrl=/project/52ec4e44b43917a25a000e96/download/zip&templateName=Math%20Expressions&compiler=pdflatex
https://www.overleaf.com/learn/File:Einstein1.png
https://www.overleaf.com/learn/File:Einstein2.png
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\[ \int_0^1 \frac{1}{e^x} =  \frac{e-1}{e} \] 

  

Lower case Greek letters are written as $\omega$ $\delta$ etc. while upper case Greek letters are 

written as $\Omega$ $\Delta$. 

  

Mathematical operators are prefixed with a backslash as $\sin(\beta)$, $\cos(\alpha)$, $\log(x)$ etc. 

 

The possibilities with math in LATEX are endless and it is impossible to list them all here. Be sure 

to check out our other articles on 

• Mathematical expressions 

• Subscripts and superscripts 

• Brackets and Parentheses 

• Fractions and Binomials 

• Aligning Equations 

• Operators 

• Spacing in math mode 

• Integrals, sums and limits 

• Display style in math mode 

• List of Greek letters and math symbols 

• Mathematical fonts 

Basic Formatting 

We will now look at how to write abstracts, as well as how to format a LATEX document into 

different chapters, sections and paragraphs. 

Abstracts 

In scientific documents it's a common practice to include a brief overview of the main subject of the 

paper. In LATEX there's the abstract environment for this. The abstract environment will put the 

text in a special format at the top of your document. 

\begin{document} 

  

\begin{abstract} 

This is a simple paragraph at the beginning of the  

document. A brief introduction about the main subject. 

https://www.overleaf.com/learn/Mathematical_expressions
https://www.overleaf.com/learn/Subscripts_and_superscripts
https://www.overleaf.com/learn/Brackets_and_Parentheses
https://www.overleaf.com/learn/Fractions_and_Binomials
https://www.overleaf.com/learn/Aligning_equations_with_amsmath
https://www.overleaf.com/learn/Operators
https://www.overleaf.com/learn/Spacing_in_math_mode
https://www.overleaf.com/learn/Integrals,_sums_and_limits
https://www.overleaf.com/learn/Display_style_in_math_mode
https://www.overleaf.com/learn/List_of_Greek_letters_and_math_symbols
https://www.overleaf.com/learn/Mathematical_fonts
https://www.overleaf.com/learn/File:Math.PNG
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\end{abstract} 

\end{document} 

 

Paragraphs and newlines 

\begin{document} 

  

\begin{abstract} 

This is a simple paragraph at the beginning of the  

document. A brief introduction about the main subject. 

\end{abstract} 

  

Now that we have written our abstract, we can begin writing our first paragraph. 

  

This line will start a second Paragraph. 

\end{document} 

 

When writing the contents of your document, if you need to start a new paragraph you must hit the 

"Enter" key twice (to insert a double blank line). Notice that LATEX automatically indents 

paragraphs. 

To start a new line without actually starting a new paragraph insert a break line point, this can be 

done by \\ (a double backslash as in the example) or the \newline command. 

Care should be taken that multiple \\ or \newlines are not used to "simulate" paragraphs with larger 

spacing between them, as this can interfere with LATEX's typesetting algorithms. The 

recommended method to do so is to keep using double blank lines to create new paragraphs without 

any \\, and then add \usepackage{parskip} to the preamble. 

You can find more information in the Paragraphs and new lines article. 

Chapters and Sections 

Commands to organize a document vary depending on the document type, the simplest form of 

organization is the sectioning, available in all formats. 

\chapter{First Chapter} 

  

\section{Introduction} 

  

This is the first section. 

https://www.overleaf.com/learn/Paragraphs_and_new_lines
https://www.overleaf.com/learn/File:Abstractsmall.PNG
https://www.overleaf.com/learn/File:Abstractnonewline.PNG
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Lorem  ipsum  dolor  sit  amet,  consectetuer  adipiscing   

elit.   Etiam  lobortisfacilisis sem.  Nullam nec mi et  

neque pharetra sollicitudin.  Praesent imperdietmi nec ante.  

Donec ullamcorper, felis non sodales... 

  

\section{Second Section} 

  

Lorem ipsum dolor sit amet, consectetuer adipiscing elit.   

Etiam lobortis facilisissem.  Nullam nec mi et neque pharetra  

sollicitudin.  Praesent imperdiet mi necante... 

  

\subsection{First Subsection} 

Praesent imperdietmi nec ante. Donec ullamcorper, felis non sodales... 

  

\section*{Unnumbered Section} 

Lorem ipsum dolor sit amet, consectetuer adipiscing elit.   

Etiam lobortis facilisissem 

 

The command \section{} marks the beginning of a new section, inside the braces is set the title. 

Section numbering is automatic and can be disabled by including a * in the section command 

as \section*{}. We can also have \subsection{}s, and indeed \subsubsection{}s. The basic levels of 

depth are listed below: 

-

1 
\part{part} 

0 \chapter{chapter} 

https://www.overleaf.com/learn/File:Sections1.PNG
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1 \section{section} 

2 \subsection{subsection} 

3 \subsubsection{subsubsection} 

4 \paragraph{paragraph} 

5 \subparagraph{subparagraph} 

Note that \part and \chapter are only available in report and book document classes. 

For a more complete discussion about the document structure see the article about sections and 

chapters. 

https://www.overleaf.com/learn/Sections_and_chapters
https://www.overleaf.com/learn/Sections_and_chapters
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                                 WEEK-12 

              Graphics and Tables in Latex 

 

Creating tables 

Creating a simple table in LATEX 

Below you can see the simplest working example of a table 

\begin{center} 

\begin{tabular}{ c c c } 

 cell1 & cell2 & cell3 \\  

 cell4 & cell5 & cell6 \\   

 cell7 & cell8 & cell9     

\end{tabular} 

\end{center} 

 

The tabular environment is the default LATEX method to create tables. You must specify a 

parameter to this environment, in this case {c c c}. This tells LATEX that there will be three 

columns and that the text inside each one of them must be centred. You can also use r to align the 

text to the right and l for left alignment. The alignment symbol & is used to specify the breaks in 

the table entries. There must always be one less alignment symbol in each line than the number of 

columns. To go to the next line of your table, we use the new line command \\. We wrap the entire 

table inside the center environment so that it will appear in the center of the page. 

Adding borders 

The tabular environment is more flexible, you can put separator lines in between each column. 

\begin{center} 

\begin{tabular}{ |c|c|c| }  

 \hline 

 cell1 & cell2 & cell3 \\  

 cell4 & cell5 & cell6 \\  

 cell7 & cell8 & cell9 \\  

 \hline 

https://www.overleaf.com/learn/File:TablesEx1.png
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\end{tabular} 

\end{center} 

 

You can add borders using the horizontal line command \hline and the vertical line parameter |. 

• { |c|c|c| }: This declares that three columns, separated by a vertical line, are going to be used in 

the table. The | symbol specifies that these columns should be separated by a vertical line. 

• \hline: This will insert a horizontal line. We have included horizontal lines at the top and 

bottom of the table here. There is no restriction on the number of times you can use \hline. 

Below you can see a second example. 

\begin{center} 

 \begin{tabular}{||c c c c||}  

 \hline 

 Col1 & Col2 & Col2 & Col3 \\ [0.5ex]  

 \hline\hline 

 1 & 6 & 87837 & 787 \\  

 \hline 

 2 & 7 & 78 & 5415 \\ 

 \hline 

 3 & 545 & 778 & 7507 \\ 

 \hline 

 4 & 545 & 18744 & 7560 \\ 

 \hline 

 5 & 88 & 788 & 6344 \\ [1ex]  

 \hline 

\end{tabular} 

\end{center} 

 

https://www.overleaf.com/learn/File:TablesEx2.png
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Creating tables in LATEX can be a bit tricky sometimes, so you may want to use 

the TablesGenerator.com online tool to export LATEX code for tabulars. The File > Paste table 

data option lets you copy and paste data from spreadsheet applications. 

 Captions, labels and references 

You can caption and reference tables in much the same way as images. The only difference is that 

instead of the figure environment, you use the table environment. 

Table \ref{table:data} is an example of referenced \LaTeX{} elements. 

  

\begin{table}[h!] 

\centering 

\begin{tabular}{||c c c c||}  

 \hline 

 Col1 & Col2 & Col2 & Col3 \\ [0.5ex]  

 \hline\hline 

 1 & 6 & 87837 & 787 \\  

 2 & 7 & 78 & 5415 \\ 

 3 & 545 & 778 & 7507 \\ 

 4 & 545 & 18744 & 7560 \\ 

 5 & 88 & 788 & 6344 \\ [1ex]  

 \hline 

\end{tabular} 

\caption{Table to test captions and labels} 

\label{table:data} 

\end{table} 

 

Note: If you are using captions and references on your own computer, you will have to compile the 

document twice for the references to work. Overleaf will do this for you automatically.' 

Adding a Table of Contents 

To create the table of contents is straightforward, the command \tableofcontents does all the work 

for you: 

\documentclass{article} 

\usepackage[utf8]{inputenc} 

  

\title{Sections and Chapters} 

\author{Gubert Farnsworth} 

\date{ } 

  

https://www.tablesgenerator.com/
https://www.sharelatex.com/project/new/template?zipUrl=/project/58a3101d13712fef4e9df258/download/zip&templateName=Learn%20LaTeX%20in%2020%20minutes:%20Part%2010&compiler=pdflatex
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\begin{document} 

  

\maketitle 

  

\tableofcontents 

  

\section{Introduction} 

  

This is the first section. 

  

Lorem  ipsum  dolor  sit  amet,  consectetuer  adipiscing   

elit.   Etiam  lobortisfacilisis sem.  Nullam nec mi et  

neque pharetra sollicitudin.  Praesent imperdietmi nec ante.  

Donec ullamcorper, felis non sodales... 

  

\addcontentsline{toc}{section}{Unnumbered Section} 

\section*{Unnumbered Section} 

  

Lorem ipsum dolor sit amet, consectetuer adipiscing elit.   

Etiam lobortis facilisissem.  Nullam nec mi et neque pharetra  

sollicitudin.  Praesent imperdiet mi necante... 

  

\section{Second Section} 

  

Lorem ipsum dolor sit amet, consectetuer adipiscing elit.   

Etiam lobortis facilisissem.  Nullam nec mi et neque pharetra  

sollicitudin.  Praesent imperdiet mi necante... 

  

\end{document} 

 

Sections, subsections and chapters are automatically included in the table of contents. To manually 

add entries, for example when you want an unnumbered section, use the 

command \addcontentsline . 

https://www.overleaf.com/learn/File:TableOfContentsEx1.png

